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Introduction

Thank you for purchasing a Moxa V2406A panel computer running the Windows 7 Embedded operating system.

The Windows 7 Embedded OS provides a simple and familiar development environment for a variety of
industrial applications.

O Software Components
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Software Components

The following software components of the Windows Embedded Standard 7 OS come pre-installed on the
V2406A computer.

Windows Embedded Standard 7
Core OS:

e 32/64-bit support

¢ Remote Client

e Remote Procedure Call

Applications and Services Development:
¢ .Net Framework 4.5

e Remote Desktop Protocol 7.1

e COM OLE Application Support

e COM+ Application Support

e MSMQ

Internet Services:

e Internet Explorer 8.0

¢ IIS 7.0

Diagnostics:

e Common Diagnostic Tools

¢ Problem Reports and Solutions

Fonts: Chinese (Trad. and Simp.), Japanese, Korean, Western, Middle Eastern, South East Asian, and South
Asian Fonts

Graphics and Multimedia:

e MPEG DTV-DVD Audio Decoder (MPEG-2, AAC)
e MPEG Layer-3 Audio Codecs (MP3)

e MPEG4 Decoders

e Windows Media Video VC-1 (WMV) Codecs
¢ DirectX and Windows Device Experience
e Windows Media Player 12
Management:

e Group Policy Management

e Windows Management Instrument (WMI)
¢ Windows Update

Networking:

¢ Extensible Authentication Protocol (EAP)
¢ Internet Authentication Service

e Telnet Server

¢ Bluetooth

e Domain Services

* Network Access Protection

e Network and Sharing Center

¢ Quality of Service

e Remote Access Service (RAS)

e Telephony API Client

e Windows Firewall

e Wireless Networking

1-2
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Security:

¢ Credential Roaming Service

¢ Credentials and Certificate Management

e Windows Authorization Manager (AZMAN)
e Windows Security Center

e Active Directory Rights Management

e Security Base

¢ Encrypted File System (EFS)

Embedded Features:

e Enhanced Write Filter (EWF)

e File-Based Write Filter (FBWF)

e Message Box Default Reply

e Registry Filter

e WSDAPI for .NET

File Systems and Data Store:

e Windows Data Access Components

e Windows Backup and Restore
Embedded Self-Health Diagnostic Software: SNMP-based remote scripting layer for monitoring, reporting,
and control

Linux

OS: Linux Debian 7

File System: EXT 4

Internet Protocol Suite: TCP, UDP, IPv4, SNMPv1/v2c/v3, ICMP, ARP, HTTP, SSH 1.0/2.0, SSL, DHCP, NTP,
NFS, Telnet, FTP, TFTP, PPP, PPPOE

Internet Security: OpenVPN, iptables firewall

Web Server (Apache): Allows you to create and manage web sites; supports PHP and XML

Secure Shell for Remote Access: SSH allows remote logins to a secure encrypted console from any
connected network

Dial-up Networking: PPP Daemon for Linux that allows Unix machines to connect to the Internet through
dialup lines, using the Point-to-Point Protocol (PPP). Works with ‘chat’, ‘dip’, and ‘dialu dip’, and ‘diald’, among
(many) others. Supports IP, TCP, UDP, and (for Linux) IPX

(Novell).

File Server: Enables remote clients to access files and other resources over the network

Watchdog: A watchdog timer that triggers a system reset upon software freezes, for both specific applications
and system-wide failures.

Application Development Software:

e Moxa API Library

e GNU C/C++ cross-compiler

e GNU C library

e Perl

Software Package:

e SNMP

e SafeGaurd technology

Terminal Server (SSH): Provides secure encrypted communications between two un-trusted hosts over an
insecure network

Tailored MIB File for SNMP Control: SNMP allows centralized network monitoring and control. With Moxa’s
proprietary MIB file, trap notifications keep network overhead low while providing monitoring and control of key
BIOS settings; internal hardware sensors; interface connectivity for DI/DO, USB, and UART; and other
peripheral devices.

1-3
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System Initialization

In this chapter, we describe how to initialize the system settings on the V2406A embedded computer when
booting up for the first time.

The following topic is covered in this chapter:

O Overview

O Initializing User Settings
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Overview

Similar to using a laptop computer for the first time, you need to specify a user name and create a user account
to start using the V2406A embedded computer. Follow the procedure described in the next section.

NOTE If you perform a system recovery on the V2406A embedded computer, the system automatically resets to the
factory defaults. You must initialize the user settings again.

Initializing User Settings

1. When you turn on the embedded computer for the first time, enter a user name for the computer.

@ o SetUp Windows:

£7 Windows Embedded
Standard 7

or your account. Your computer's name is managed by your organization's

Type 2 user name (for example, John):

Copyright © 2010 Microsoft Corporation. All rights reserve
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2. Type a password and retype the password to confirm.

You may also type a password hint that you can refer to if you forget your password. If you do not want to

set a password, leave all three fields blank. Click Next to continue.

@ o SetUp Windows

Set a password for your account

Creating a password is a smart security precaution that helps protect your user account from
unwanted users. Be sureto remember your password of keep it in a safe place.

Type a password (recommended):

Retype your password:

Type 2 password hint:

Choose a word or phrase that helps you remember your password,
I you forget your password, Windows will show you your hint.

3. Select a Windows update option.

G 4 et Up Windows

Help protect your computer and improve Windows automatically

Use recommended settings

Install updates, help maks safer, check

online for solutions to problems, and help Microsoft improve Windows.

Installimportant updates only
nly nstall security updstes and other important updates for Windows,

Ask me |ater
Until you decide, your computer might be vulnerable to security threats.

Leam more sbout each option
When you install updates only, is sentto
Microsoft. The information is not used to identify you or contact you. To turn off these seftings

Iater, search for "Turn off recommended setting’in Help and Support. Read the privacy statement

2-3
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4. Select the computer’s current location.

Windows automatically applies the appropriate network settings based on the type of network you select.

@ o SetUp Windows

Select your computer's current location

This computer is connected to a network. Windows will automatically apply the correct network
settings based on the network's location.

Home network
I all the computers on this network are at your home, and you recognize them, thisisa

trusted home network. Don't choose this for public places such as coffee shops or
airports.

Work network
I all the computers on this network are at your workplace, and you recognize them, this

is a trusted work network. Don't choose this for public places such as coffee shops or
airports.

Public network
! I you don't recognize all the computers on the network (for example, you'rein a coffee

shop or airport, or you thisisa

¥ you aren't sure, select Public network.

5. When the Windows desktop screen appears, you can start using your V2406A embedded computer.

2-4
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Configuring the Serial Interface

This chapter describes how to configure the serial interface on the V2406A embedded computer.
The following topics are covered in this chapter:

O Overview

O Configuring the Serial Interface Mode
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Overview

The V2406A supports the following serial modes: RS-232, RS-485-2-wire and RS-422/485-4-wire. These
modes can be configured from COM1 to COM4.

Configuring the Serial Interface Mode

Complete the following steps to configure the serial interface mode:
1. Open Device Manager.

2. Under Multi-port serial adapters, right-click MOXA CP-114EL Series (PCI Express Bus) and select
Properties.

File Action View Help

& | @ E Hm & B &S

4% moxa-PC

/% Computer
g Disk drives
B, Display adapters
U5 Human Interface Devices |
@ IDE ATA/ATAPI controllers

» =2 Keyboards
)| Mice and other pointing devices
& Monitors
¥ MOXA Embedded Drivers

4" Multi-port serial adapters

[TF MOXA CP-1L4EL Series (PCl Ermenes Buse)

¥ Network adapters Update Driver Software...
¥ Ports (COM &LPT) Disable
B Processors Uninstall
& Ramdisk
» % Sound, video and game controlle Scan for hardware changes
1 System devices P =
5@ Universal Serial Bus controllers I IORE I

Opens property sheet for the current selection.

3. Click the Ports Configuration tab and select the COM port to configure (for example, COM1); then, click
Port Setting.

- 5
MOXA CP-114EL Series (PCI Express Bus) Properties [

Geneml Ports Configuration | Driver |DHHBIR’°W

4 COm 4 High High RS-232 Disable

Help I
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Configuring the Serial Interface

4. From the Interface drop-down list, select a serial mode and click OK.

NOTE

By default, the serial mode setting applies to all ports on the V2406A computer. If you want to configure the
serial mode for a port, clear the Set the change to all port check box.

[Port 1 =)

Poit Number

IE!OI-H [urrert) -

¥ Aute Erumerating COM Number

BxFIFD Level High -

[V Setthe change to all ports

Tx FIFO Level High -
W Setthe change to all ports

RS-485 4w i

[RS232
28t the R 422

Interface

Teimination R esistor

¥ Setthe change to all ports

[1]4 Cancel

.

5. Check that the serial interface is correct.

-

MOKA CP-114EL Series (PCI Express Bus) Properties

=3

General | Ports Corfiguration | Driver | Details | Resources

Port | COM Mo, | RxFIFO Level| T« FIFO Level | Interfa

1 Ok | 5 e
2 oMz High High F5-485 4 Dizable
3 COM3 High High F5-485 4w Dizable
4 COMA4 High High F5-485 4w Dizable

Port Infa

ermination R esistor

Help

'art Setting

ok | [ Ccancdl
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Enabling Embedded Filters

In this chapter, we describe how to enable the V2406A’s embedded filters.
The following topics are covered in this chapter:

O Enhanced Write Filter
» Overview
» Enabling Enhanced Write Filter
» Committing Data and/or Disabling EWF
O File-Based Write Filter
» Configuring File-Based Write Filter
» Excluding Files from FBWF Protection
» Managing Temporary Files Cached in the Overlay
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Enhanced Write Filter

Overview

Enhanced Write Filter (EWF) enables you to protect a volume from unauthorized writes by making the main
operating system (OS) drive a write-protected volume, effectively making the system a read-only system for
most users. This provides much stronger protection against malicious computer attacks (such as trojans,
worms, and viruses).

Enhanced Write Filter (EWF) allows Windows 7 users to protect data on their storage drive from permanent
changes of any sort, at the lowest level of hardware protection available: the bit level. EWF allows the OS to
boot from the hard disk, but protects the system by creating a virtual file system called an overlay. All writes
to an EWF-protected volume (the hard disk in the following figure) are only recorded on this virtual overlay
(the EWF Volume in the following figure), which is stored independently in random access memory (RAM).

Because EWF does not write data directly to the hard disk but instead only records system writes to this virtual
RAM overlay, any data that is “written” during system operation will disappear upon the next re-boot. This
approach allows the system to operate as if it is writeable when in reality all OS and user-space file systems are
stored in a permanent, read-only state.

If required, data written to the overlay can be committed to the protected volume, but this requires additional
setup and permissions that can only be granted by the administrator.

The following figure shows an overview of the EWF structure.

File resd faite File readinite File readiarite

. kg

COFS ArEE FAT
.1. - d I. ol L S . | - l—
Ry
2 t |
Bl EWWF Valume
Fead & Fead &
| | : | ; Commit
|CDRom dass driver | | Disk dass driver -|~-
i :
|Read
| L ite
- PR, :
El-Torito Hard disk

CO-ROm

For more detailed information about EWF configuration and usage, refer to the following resources:

e Visit Microsoft’s EWF Volume Configuration help pages.

e See Microsoft's EWF overview on the official Microsoft EWF help pages.
e See Microsoft’s detailed description of EWF modes on the EWF help pages.
e See Microsoft’s detailed description of the EWF API.

e For EWF commands, refer to the MSDN web site:
http://msdn.microsoft.com/en-us/library/ms940853%28v=winembedded.5%29.aspx
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Enabling Embedded Filters

Enabling Enhanced Write Filter

Follow these steps to enable Enhanced Write Filter (EWF):

1. To open EWF, double-click the padlock icon in the system tray.

2. You may need to show hidden icons in the system tray.

3.

a Z: Disabled i

Customize...

€ (%

545 PM

6/18/2013

—

=]

In the Volume Information area, select the partition you want to enable write-protection on and click

Configure....

Volume information

MName

Cverlay Type State

RAM (Reg)

Disabled

Pending Command

Mo command

HORM information
HORM state:

Disabled

Show volume details. ..

Qverlay information

Cverlay size:

Space available:

I Configure... I

Show overlay details...

Cloze

4-3
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4. The Configuration dialog box appears. Select Enable from the Pending command drop-down list and click

OK.
F T —— &l
Enhanced Write Filter S
Configuration
Mame Cverlay Type  State Pending Command
. Volume 1 RAM {Req) Disabled Mo command
{ii= RAM (Req) Disabled Enable
Pending command: I[Enable =
|:| HORM support
i 0K } [ Cancel ] [ Apply ] [ Help
&

5. Reboot the system.

Log into the system and verify that the padlock icon in the system tray indicates that the drive volume is
locked with EWF.

wWolumel Disabled
s~ Enghled

Customize...

4-4
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Committing Data and/or Disabling EWF

Perform the following steps to write (or commit) data to an EWF-enabled drive.

NOTE You must have administrator privileges to commit data to the drive.

1. Double-click the padlocked drive in the system tray.

You may need to show hidden icons in the system tray.

wWolumel Disabled
Z: Enabled

Customize...

o i y  S30PM
Gl = N g12472014

2. In the Enhanced Write Filter: Overview dialog box, select the drive you want to configure and click
Configure.

Volume information

MName COverlay Type State Pending Command

RAM (Reag) Enabled Mo command

Show volume details. ..

HORM information Qwverlay information
HORM state: Digabled Cwerlay size:

Space available:

Configure... Show overlay details...

Close

4-5
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3. In the Enhanced Write Filter Configuration screen, select a drive volume; then, select an option from the
Pending Command drop-down list:
¢ No Command
. Disable: Disables EWF on the selected drive. The system automatically reboots if you select this
option.
¢ Commit: Writes all current system changes to the hard drive.

¢ Commit and Disable Live: Writes all current data and changes to the system, and also turns off EWF
on the selected drive (so that all future data and system changes will also be committed to the drive).
The system does not automatically reboot if you select this option.

Enhanced Write Filter [
Configuration

MName COverlay Type State Pending Command

... Volume1 RAM (Re Dizabled Mo command
[ RAM (Reg) Enabled Mo command
==

Pending command: | Mo command g

Mo command
Disable
Commit

| |HORM support

QK ] I Cancel Apply

—— —— ——— —

NOTE

For detailed information, go to the Microsoft website at
http://msdn.microsoft.com/en-us/library/ff794092(v=winembedded.60).aspx.

File-Based Write Filter

This section describes how to use the File-Based Writer Filter (FBWF). Note that when Enhanced Writer Filter is
enabled, the File-Based Writer Filter function will not work.

According to Microsoft:

“File-Based Write Filter (FBWF) allows the Windows Embedded platform to maintain the appearance of read
and write access on write-sensitive or read-only storage. FBWF makes read and write access transparent to
applications.

Writing to storage media may be undesirable or impossible in embedded devices. FBWF redirects all writes
targeted for protected volumes to a RAM cache called an overlay. Used in this context, an overlay is similar to
a transparency overlay on an overhead projector. Any change made to the overlay affects the picture as seen
in the aggregate, but if the overlay is removed, the underlying picture remains unchanged.”

FBWF supports an advanced ESF feature, which allows users to specify which directory to write data to. The
default directory is c:\temp. The advanced feature allows you can read/write data to disk without committing
an action.

4-6
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Configuring File-Based Write Filter

Complete the following steps to enable the File-Based Write Filter (FBWF) feature. Note that although FBWF
and EWF may both be enabled on the same machine, FBWF does not protect a volume that is already protected
by EWF. Similarly, EWF does not protect a volume that is already protected by FBWF.

NOTE Before using FBWF, make sure that you disable EWF.

1. Double-click the padlock icon in the system tray.
You may need to show hidden icons in the system tray.

NOTE When disabled, the EWF and FBWF icons in the system tray look the same. To verify that you have opened the
correct writer filter program, check the screen title.

Protected: =

5:39 PM
1172472014

2. In the File Based Writer Filter: Overview screen, click Configure.

File Based Write Filter: Overview ==

Current  After restart
State Dizabled Disabled
Cache compression  Disabled Disabled
Cache pre-allocation Disabled Disabled
Cache threshold 128MB 128 MB
Protected volumes

Show exdusion list... Configure...

Runtime information:

RAM used for directory structure: 0 bytes

RAM used for file data: 0 bytes

Close

3. To enable FBWF protection on a storage drive, perform the following actions:
a. Select Filter state enabled and Cache pre-allocation enabled.
b. In the Volume Configuration area, select the storage drive you want to protect and click Protect.
c. Click Apply or OK.
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) Wi Fiker —
1A

ration | Exclusion List | Cache Content| I B

Filter'configuration

[V|Filter state enabled Currently: Disabled

Cache compression eng

l [¥] cache pre-allocation enabled ] Currently: Disabled

Cache threshold: 128 = M8
Volume configuration
Volumes State After reboot

...bbf71292-a... Unprotected Unprotected

NOTE

To minimize memory usage on the overlay cache, select Cache compression enabled. However, cache
compression decreases performance when accessing protected volumes.

Select Cache pre-allocation enable to set the memory space available for the overlay cache when the
system starts up, instead of adjusting it as needed.

You cannot enable cache pre-allocation and cache compression at the same time.

The cache threshold field sets the amount of memory that can be used by the write filter for the overlay
cache. The default value and size limits for the overlay cache vary depending on the operating system.

4. Reboot the system.

5. Log into the system and verify that the padlock icon in the system tray displays a number and indicates that
FBWF is enabled on a drive. The following figure shows an example.

Protected:
C:
@8 Jg|%
=,
&
Customize...
H [
s
b/ 1A

4-8
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Excluding Files from FBWF Protection

1. Double-click the FBWF icon in the system tray.

You may need to show hidden icons in the system tray.

2. In the File Based Write Filter: Overview window, click Configure.

File Based Write Filter: Overview

()

Current  After restart
State Enabled Enabled
Cache compression  Disabled Disabled
Cache pre-allocation Enabled Enabled
Cache threshold 128MB 123 MB
Protected volumes  C: C:
[ Show exdusion list... Configure...

[ Show cache content...

Runtime information:

RAM used for directory structure;

RAM used for file data:

a.

47 MB

13.5MB

Close

3. Click the Exclusion List tab and configure the following fields:

¢ Volume name - Select a drive volume from the drop-down list.

e Add path - click the ellipsis (...) button to select a directory or file you want to exclude from FBWF

[ File Based Write Filte

]

- Exdusion List | Cache Content

Volume name:

Path

r Program Files\CMAK \cmak. exe

Exduded after reboot I

Add path: \Program Files\CMAK \cmak. exe

(][]

[ OK ] [ Cancel

)

Apply

)

4. Click the Cache Content tab and click Apply and OK.

4-9
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File Based Write Filter

| Configuration | Exdusion Lisfl| Cache Content |I
———

Path

Yinetpubtemp'appPools\APC 2F 78, tmp
ProgramData'Micro. .. \SystemIndex. 1. Crwl
ProgramData\Micro. .. \SystemIndex. 1.gthr
ProgramData\Microsoft\Search. .. \MS5.chk
ProgramDataMicrosoft\Search. .. \MS5.log
ProgramData\Microsoft\Se. . . \Windows.edb
ProgramData\Microsoft\Search. .. \tmp.edb
Windows'bootstat.dat
Windows'infsetupapi.dev.log
Windows'prefetch \AgGIFaultHistory.db

Cache size

T2.0KB
4.00 KB
4.00 KB
8.00 KB
8.00 KB
512KB
8.06 MB
4.00 KB
36.0KB
4.00 KB

Add to exdusion list

Restore Commit

[ QK J [ Cancel

) (e

5. Reboot the system to make the changes take effect.

Managing Temporary Files Cached in the Overlay

1.

On the Cached Content tab, you will see all the files currently cached in the RAM overlay. Three commands

are available:

Commit: Save a file from the cache to permanent storage, delete the file from the overlay, and

overwrite the original file.

Restore: Return the file to its original state, remove the file from the overlay cache and discard the
changes that added the file to the cache.

Add to exclusion list: Adds the file to the exclusion list after the next restart. This will delete the file
from the cached overlay and replace the current file in permanent storage with the modified cache file.

[File Based Write Filter

| Configuration | Exdlusion List| Cache Content |

| Path

Cache size T
Yinetpub\temp'\appPools\APC2F 78. tmp 72.0KB |
ProgramData\Micro. .. \SystemIndex. 1.Crwl 4.00 KB [
ProgramData'Micro... \SystemIndex. 1.gthr 4.00 KB I
ProgramData\Microsoft\Search. .. \M55.chk &.00KB
ProgramData\Microsoft\Search. .. \M55.log .00 KB
ProgramDataMicrosoftise. .. \Windows. edb 512 KB
ProgramData\Microsoft\Search. .. \tmp.edb 8.06 MB
Windows'bootstat.dat 4.00 KB
Windowvs! tpani dev log S50 KE
Windos'prefetch \AgGIFaultHistory .db 4.00 KB e

[ Add to exdusion list ][ Restore ] I Commit I

[ Ok ] ’ Cancel

) (oo

2. The most common usage of the Cache Content filter will likely be to permanently write content to the hard
drive. To do this, select the file you wish to write to permanent memory and click on the commit button.
This will delete the file from the cached overlay and replace the current file in permanent storage with the

modified cache file.
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Keep in mind that committing a configuration or application file will permanently alter the setup and/or
performance of the application or system.

File Based Write Filter =3

| Configuration | Exdusion List| Cache Content |

= st e S
[Errrr——rT |

e 200 TIES 7 T Vi MIanagement] ool Oper. - TO0rD

... \W2408WES7_FBWFManagementTool_Oper... 4,00 KB

... \W2408WES7_FBWFManagementTool_Oper... 4,00 KB

... \W2406WES7_FBWFManagementTool_Oper... 4.00 KB

.. \W2406WES7_FBWFManagementTool_Oper... 938 KB

... \W2408WES7_FBWFManagementTool_Oper... 16.0KB

... \W2408WES7_FBWFManagementTool_Oper... 48.0 KB

... \W2406WES7_FBWFManagementTool_Oper... 16.0KB

l | [ - | [

[ Add to exdusion list ] [ Restore i [ Commit ] I

Cox Jlew ]

For more details about FBWF configuration and usage, refer to the Microsoft help file that came with your
computer, or go to the following websites:

e  Microsoft’s FBWF Installation and Configuration help pages.

e Microsoft’'s FBWF overview on the official Microsoft FBWF help pages.
e  Microsoft’'s detailed description of FBWF features on the FBWF help pages.

e  Microsoft’s detailed description of the FBWF API.
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5

Moxa Diagnostic Package

In this chapter, we describe the software package that can be used to monitor the system status of the V2406A
computer.

The following topics are covered in this chapter:

O Installing Moxa Diagnostic Utility
O Using Moxa Diagnostic Utility
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Installing Moxa Diagnostic Utility

To use Moxa Diagnostic Utility on the V2406A computer, first install the Moxa Diagnostic package.
Complete the following steps to install the Moxa Diagnostic package.

1. In the \utility\mxdiagnostic\ folder on the software DVD, double-click mxDiagnosticTool.msi.

2. A Welcome screen appears. Click Next.

4] Moxa Predictive Maintenance Diagnostic Tool E‘_‘ﬂ
|€‘“

Welcome to the Moxa Predictive Maintenance
Diagnostic Tool Setup Wizard

The inztaller will guide pou through the steps required to install Moka Predictive M aintenance
Diagrostic Tool on pour conmprter.

WARMNIMG: This computer program is protected by copyright law and intermnational treaties.
Unauthonzed duplication or distnbution of this program, or any portion of it may result in severe civil
of criminal penalties, and will be prosecuted to the maxinmum extent pozsible under the law.

3. Accept the default folder location or click Browse to select an installation folder; then, click Next.
1§ s s s Segror o I =+ =

Select Installation Folder

| The installer will install Moxa Predictive Maintenance Diagnostic Tool to the following folder.
To install in this folder, click “Nest". Ta install to a different folder, enter it below or click "Browse".

| Folder

[C:\Ptegram Files\MOXa\Maxa Predictive Maintenance Diagnostic Tc Browse... ]
1 Disk Cost...

Install Moxa Predictive Maintenance Diagnostic Tool for yourself, or for anyone who uses this
computer:

@ Everpone

) Just me

Cancel J [ < Back Mexd »
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4. Click Next to continue.

]

Confirm Installation

The installer iz ready to install Moxa Predictive taintenance Diagnostic Tool an your computer.

Click “Mext" ta start the installation,

Cancel ] [ < Back ] [ Ment »

5. Click Close to complete the installation process.

12 Moxa Predictive Maintenance Diagnastic Toc

Installation Complete

Mawa Predictive Maintenance Diagnostic Tool haz been succezsfully installed,

Click "Close" to exit.

Flease uze Windows Update to check for anw critical updates ta the MET Framewark.
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Using Moxa Diagnostic Utility

This section describes how to use the Moxa Diagnostic Utility on the V2406A.

1. From the Start menu, click All Programs > Moxa > Moxa Predictive Maintenance Diagnostic Tool >
Moxa Predictive Maintenance Diagnostic Tool.
(@ Default Programs

& Desktop Gadget Gallery

@ Intemnet Explorer moxa
= Windows Fax and Scan

WD Windows Media Player Documents
1 Windows Update
< XPS Viewer Pictures

. Accessories
| Intel

Music

. Maintenance

Moxa Computer
|1 Moxa Hot Swap Function For Disk Drive
|| Moxa Predictive Maintenance Diagnost|

F] Moxa Predictive Maintenance Diagnostic Tool |

\\\\\\\\ 'and Printers
. Startup

| Subsystem for UNIX-based Applications

trol Panel

Defauit Programs
Help and Support

Windows Security
4 Back

|search programs and files

2. The System Temperature tab shows the current and threshold values of the CPU and system
temperatures (in degrees Celsius).

When the current temperature exceeds the threshold value, the screen displays “warning” in the Status
field and logs the status change.

iagnostic Toc

s imnpesypeneallspenpespengs

ltem Name

CPU Temperature

System Temperat..

4. Click Yes to save the changes.

[ Confirm — I“_J

Threshold value has been changed, do you want to save it?
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5. Click the System Voltage tab to view the current system voltages (in V).

a-l Moxa Predictive Maintenance Diagnastic Tox

OO 0000000 O O T oo

Threshold Curmrent
Value Voltage

NOTE V_CPU = Voltage for processor core
VTT_CPU = Voltage for L3 shared cache, memory controller, and processor I/O power rail (Uncore)
VCCSA_CPU = Voltage for CPU System Agent
V1_0_5 = (VCCIO) = Voltage for processor uncore
V5_0 = Voltage for other chips

6. Click the System Frequency tab to view the current system frequency.

ce Liagnostic 1o

lussmmspmnpenpalnusanpeniengs

1| _

System Temperature | SystemVoltage
| tem Name Threshold

Value

L0 O OO i O e
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8. Click the Settings tab to set the polling interval and log options.

NOTE If the folder you specify in the Log Path field does not exist, the system automatically creates the folder when

new logs are recorded.

. o/ Moxa Predictive Maintenance =

LU OO OO o O T e e

-] T

System Temperature | SystemVoltage | SystemFrequency | SystemResource |

Polling Interval : m (seconds)

Enable Log

Log 27140 C:\Program Files'\Moxa\Moxa Predictive Maintenance Diagnostic Tool\Log SelectFile

9. To save the settings, click Apply.
10. Click Yes to confirm.

-

It will apply the settings immediately, are you sure?

e ) [k
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Moxa SynMap Package

In this chapter, we describe the software package that can be used to easily control and monitor V2406A
computers.

The following topics are covered in this chapter:

O Moxa SynMap Package

» Overview

» Moxa SynMap OID List

Installing CrystalDiskInfo
Installing the Moxa SynMap Package
Installing MXview

Configuring MXview

Loading the Moxa SynMap MIB File
Loading the Host Resource MIB File
Using Moxa SynMap OIDs

Using HOST RESOURCE OIDs

aoaoaaogoaogoaogoaoao
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Moxa SynMap Package

Overview

SynMap is Moxa'’s revolutionary software virtualization tool, which adapts SNMP into a fully portable remote
procedure interface. SynMap allows engineers to automate remote processes using SNMP object identifiers
(OIDs) rather than device-specific addresses, making a scripted SynMap procedure fully interoperable with any
other SynMap device. This means that a script created for one SynMap device may be directly copied to another,
immediately conferring the same functionality. This eliminates the need to rewrite and compile code for newly
configured devices, significantly reducing maintenance and deployment times.

SNMP is lightweight and easy-to-configure, and has long been popular with IT professionals. SNMP also enjoys
comprehensive native support in high-level languages, including .NET, Java, Python, and Ruby. For these
reasons, the SynMap framework has re-purposed SNMP into a universal configuration and control interface for
remote procedures, adapting it to not only monitor and control device internals like temperature, BIOS
parameters, and local interfaces, but also to report on and automate tasks at the process layer, as well. Easily
integrated into any existing Network Management System (NMS), SynMap devices are a flexible and
cost-effective upgrade that returns obvious benefits to any IA network.

SynMap currently allows you to use SNMP for remote monitoring and control of a select set of computer
processes, but its list of features is rapidly growing. Using SynMap's fully portable scripts, engineers will soon
be able to:

e Access, monitor, control, and report on digital I/O at both the process and hardware layers.
e Use OIDs to monitor, configure, and give process control over serial ports and other interfaces.

e Monitor and control system attributes and process events via any NMS.

e Build automated remote procedures using SynMap OIDs called by simple shell scripts, or a preferred
high-level language like Python, Perl, or VBScript—all without any need for low-level C APIs, or
platform-specific libraries.

e Significantly simplify and reduce development times for custom utilities and automated executables.

e Gain scripting and automation independence from OS-dependent libraries.

All of this may be achieved using the simple, reliable, and familiar SNMP, the easily accessible standard every
IT engineer knows. Discover how Moxa is expanding automation frontiers with the innovation we call SynMap.

Moxa SynMap OID List

For a complete listing of Moxa SynMap OIDs, refer to Appendix A: Moxa SynMap OID Table.
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Installing CrystalDiskInfo

Complete the following steps to install CrystalDiskInfo, a disk health diagnostics tool that allows you to monitor
the health of a disk.

1. On the software DVD, click CrystalDiskInfo6_1_9a-en.exe in the \utility\mxSynMap\ folder.
2. A Welcome screen appears. Click Next.

Setup - CrystalDiskInfo E\ = \EI

Welcome to the CrystalDiskInfo
Setup Wizard

This will install CrystalDiskInfo 6.1.9a on your computer,

Itis recommended that you dose all other applications before
continuing.

Click Mext to continue, or Cancel to exit Setup.

[ Mext = J[ Cancel

3. Select I accept the agreement and click Next.
ﬁ Setup - CrystalDiskinfo (o] @ '1

License Agreement
Please read the following important information before continuing.

Please read the following License Agreement. You must accept the terms of this
agreement before continuing with the installation.

A. CrystalDiskInfo - Simplified BSD License -
B. OpenCandy End User License Agreement

A, CrystalDiskInfo - Simplified BSD License

Copyright (c) 2008-2014 hiyohiyo. All rights reserved.

Redistribution and use in source and binary forms, with or without modification,
are permitted provided that the following conditions are met: Dt

© 1 accept the agreement;
_) 1 do not accept the agreement

<Back | Next> | [ conce
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4. Accept the default destination folder or click Browse to select one; then, click Next.

"Bl Setup - CrystalDiskinfo o @ ==

Select Destination Location
Where should CrystalDiskInfo be installed?

l Setup will install CrystalDiskInfo into the following folder.

To continue, dick Next. If you would like to select a different folder, dick Browse.,

C:\Program Files\CrystalDiskInfo Browse. ..

At least 6.3 MB of free disk space is required.
CrystalDiskInfo 6,1,9a

< Back ” Mext = ]’ Cancel ]

5. Accept the default Start menu folder or click Browse to select one; then, click Next.
Setup - CrystalDiskInfo

Select Start Menu Folder
Where should Setup place the program's shortcuts?

i Setup will create the program's shortouts in the following Start Menu folder.

To continue, dlick Mext, If vou would like to select a different folder, dick Browse.,

CrystalDiskInfo Browse...

[ Don't create a Start Menu folder
CrystalDiskInfo 6.1,9a

< Back ” Mext = ]’ Cancel
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6. Click Next.

Setup - CrystalDiskinfo

Select Additional Tasks
Which additional tasks should be performed?

Select the additional tasks you would like Setup to perform while installing
CrystalDiskInfo, then dick Next.

Additional icons:

CryskalDiskInfo 6.1, 9a

< Back ][ Mext = J[ Cancel

7. Click Install.

51 Setup - CrystalDiskinfo

Ready to Install
Setup is now ready to begin installing CrystalDiskInfo on your computer.

Click Install to continue with the installation, or dick Back if you want to review or
change any settings.
Destination location: -
C:\Program Files\CrystalDiskInfo
Start Menu folder:
CrystalDiskInfo
Additional tasks:
Additional icons:
Create a desktop icon

[ <Back |{ Instal | [ cancel |
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8. Click Finish.
Eoep - CyaaiDente =] @ | 2=

Completing the CrystalDiskInfo
Setup Wizard

Setup has finished installing CrystalDiskInfo on your computer.
The application may be launched by selecting the installed
icons,

Click Finish to exit Setup.

@i

9. Add a shortcut in the startup folder to execute the program when system boots up.

Installing the Moxa SynMap Package

Before you install the Moxa SynMap Package, disable the Windows SNMP server. Complete the following steps:

1. From the Start menu, right-click Computer and select Manage.

Calculator

:‘J Paint o

Documents

Pictures
Music

Computer

Manage

Map network drive...

Disconnect netwaork drive...

Show on Desktop

Rename

Properties

> AllPrograms

\ Search programs and files

2. In the Computer Management screen, select Services under Service and Applications.
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File Action View Help

|

.-51gomputerManagement(ana\ . Services Actions
a ff} System Tools

= Services
b (D) Task Scheduler SNMP Service Name Description Status Startup Type *
v [@] Event Viewer
I @z] Shared Folders Stop the service

i # Local Users and Groups || Restart the service

More Actions
Remote Desktop ...  Remote Des... Manual
i Remote Desktop S.. Allows user... Manual SNMP Service
Sl i Remote Desktop S... Allows ther... Manual ors: Aciions
‘:Remote Procedur... TheRPCSS .. Started Automatic
=4 Device Manager =
@ g, Description: . Remote Procedur... In Windows... Manual
4 =3 Jtorage Enables Simple Network
=% Disk Management Management Protecol (SNMP) *
4 T4 Services and Applications || requests to be pracessed by this . RIP Listener Listensforr.. Started  Automatic
computer. If this service is stopped, % Routing and Rem...  Offers rou Dicabled

the computer will be unablete {:RPCEndpoint Ma... ResolvesRP.. Started Automatic
process SNMP requests, If this senvice

is disabled, any services that explicitly
i L& Message Queuing depend on it will fail to start. f: Secure Socket Tun... Provides su... Manual

- 58 Indexing Service i Security Accounts.. Thestartup.. Started  Automatic

4 Security Center The WSCSV...  Started Automatic (D...
‘o Server Suppertsfil..  Started Automatic

5 Shell Hardware De... Provides no.. Started Automatic

(% Simple TCP/IP Ser... Suppertsth.. Started  Automatic

f: Smart Card Manages ac... Manual

% RemoteRegistry  Enables rem... Manual

%% Secondary Logon  Enables star.. Manusl

ecerves tra...
i Software Protection  Enables the ... Automatic (D...
£ S5DP Discovery Discaovers Started Manual
2 Superfetch Maintains a... Automatic
% System Event Moti... Monitors sy.. Started Automatic
5 Task Scheduler Enables a us... Started Automatic
55 TCP/IP MetBIOS H... Providessu...  Started Automatic

< m ]

Extended A Standard /

3. In the Services pane, double-click SNMP Service.

4. In the SNMP Service Properties window, select Manual from the Startup type drop-down list and set the
Service status field to Stopped.

SNMP Service Properties (Local Computer) M

General | Log On | Recovery | Agert | Traps | Security | Dependencies |

Service name:  SNMP

Diisplay name: SMNMP Service

Descrintion: Enables Simple Metwork Management Protocol o~
cscapiion [SNMP) requests to be processed by this computer.

Path to executable:
CAWindows'\System 32 snmp exe

Startup type

Help me configure service statup options.

ISer\rice status:  Stopped I

Start Stop Pause Resume

*You can specify the start parameters that apply when you start the service
from here.

Start parameters:

[0k J[ Cancd J[ sesy ]

5. Click Apply and OK to disable the Windows SNMP service.
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Moxa SynMap Package

To install the Moxa SynMap package, complete the following steps:

1.

2. A Welcome screen appears. Click Next.

ﬁ Moxa SynMap

= - |

Welcome to the Moxa SynMap Setup Wizard LA

The inztaller will guide you through the steps required to install Maxa Synkd ap on your computer.

WwARMIMG: This computer program iz protected by copyright law and international treaties.
Unauthaorized duplication or distibution of this program, or any portion of it, may result in severe civil
or criminal penalties, and will be prosecuted to the maximum extent possible under the law.

Cancel < Back

On the software DVD, double-click mxSynMap_setup in the \utility\mxSynMap\ folder.

b

Accept the default installation folder or click Browse to select one

; then, click Next.

1

ﬁ Moxa SynMap

Select Installation Folder LA

The installer will install Moza Syntap ta the following folder.

Tainstall in this falder, click "Mext". To install to a different folder, enter it below or click "Brovwss".

Folder:

C:%Program Filegihd DA oxa Synkdaph Browsze...
Dizgk. Cost...

Install Moxa SynMap for yourself, or for anmyone who uses this computer:

@ Everyone

Just me

Cancel | | < Back | [ [ et >

h

Click Next to continue.
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ﬁ Moxa SynMap l _ S

Confirm Installation A

The installer is ready to install Moxa SynMap on your computer.

Click "Mext" to start the installation,

Cancel ] ’ < Back ] | Mext >

h

5. Click OK to continue.

Met-SNMP Agent (==l

|0I Met-EMMP Agent successfully registered as a servsice

6. When the installation process is complete, click Close.

ﬁ Moxa SynMap [ —_ -Ehl

Installation Complete A

Maoxa Syntap has been successfully installed.

Click "Cloge" to exit.

Please use Windows Update to check for any critical updates ta the MET Framework.

Cancel < Back

b

7. When prompted, click Yes to restart the V2406A to use the SNMP functions.

-
5
I

¥ou rust restart paur sypstem far the configuration changes made to Moxa SynMap to take
effect. Click Yes ta restart now ar Ma if you plan to manually restart later.

fE! Moxa SynMap
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Installing MXview

This section describes how to use the MIB browser (mxView) to monitor or control Moxa SynMap OIDs. If you
already have your own MIB browser, skip this section.

Complete the following steps to install the MXview package:

1. On the software DVD, double-click MXView_Trial_V2.4.exe in the \utility\mxViewTrial folder.
2. In the Select Setup Language screen, select a language from the drop-down list and click OK.

Select Setup Language ‘ @

Select the language to use during the
installation:

English v

3. Click Next.

Welcome to the MXview Setup
Wizard

This will install MXview on your computer,

It is recommended that you dose all other applications before
continuing.

Click Mext to continue, or Cancel to exit Setup.

License Agreement
Please read the following important information before continuing.

Please read the following License Agreement. You must accept the terms of this
agreement before continuing with the installation.

MOXA END-USER LICENSE AGREEMENT -
FOR MXview SOFTWARE

IMPORTANT: Please Read This Agreement Before Using The Software
Indicated Above.

This End-User License Agreement ("EULA™) is a legal agreement between you,
the Customer (zither as an individual or a single entity), and the Owner concerning
this spacial purposs (“System”) computer davice that includes cartain Owner

mmfbrenn innballnd mun s Crenbane Tantnlline aner e o

[ R

@) I accept the agreement

(2 I do not accept the agreement

< Back ” Mext = l[ Cancel
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5. Click Next.

MXview Trail Version License
License

M¥view license (20 Devices)

License

[ < Back " Mext = ][ Cancel ]

6. Accept the default destination folder or click Browse to select one; then, click Next.
' (== )

Select Destination Location
Where should MXview be installed?

l Setup will install MXview into the following folder.

To continue, dick Next. If you would like to select a different folder, dick Browse.

:\Program Files MoxaMxview Browse...

Atleast 77.9 MB of free disk space is required.

< Back ]i Mext = ][ Cancel

7. Click Next to continue.

ﬁl Setup - MXview —m(wl=k

Select Start Menu Folder
Where should Setup place the program's shortcuts?

l Setup will create the program's shortcuts in the following Start Menu folder.

| To continue, dick Next. If you would like to select a different folder, dick Browse.

oxa MXstudio MXview Browse...

< Back " Next > I’ Cancel
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8. Click Next to continue.

Select Additional Tasks
Which additional tasks should be performed?

Select the additional tasks you would like Setup to perform while installing MXview,
then dick Next.

Additional icons:

[ Register MXview to the Windows service

< Back " Mext = ][ Cancel

9. Click Install.

ey E=mmese

Ready to Install
Setup iz now ready to begin installing MXview on your computer.

Click Install to continue with the installation, or dick Back if you want to review or
change any settings.

Destination location:
c:\Program FilesMoxa\Mxview

Start Menu folder:
Moxa

Additional tasks:
Additional icons:
Create a desktop icon

[ <Bak | Instai

10. Wait until the installation process is complete.

Installing
Please wait while Setup installs M¥view on your computer,

Extracting files...
c:\Program FilesMoxaMXview\script\upgradeDB_traffic.sqgl
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11. Set the HTTP port to 81 and click Next.

Set Service Parameters
FPlease spedfy the server port settings.

Enable HTTP
Server [P
[1270.0.1
HTTPS Port
443

12. Select Yes, restart the computer now and click Finish to reboot the system

Completing the MXview Setup
Wizard

To complete the installation of MXview, Setup must restart
your computer. Would you like to restart now?

@ ¥es, restart the computer now:

() Moy, I will restart the computer later

[ <Bak || Fnsh |

13. fter the computer is restarted, the MXview Service shortcut appears on the computer desktop.

Configuring MXview

Complete the following steps to configure MXview:

1. Double-click the MXview shortcut on the desktop.
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2. Click Start to continue.

MXview
I8 Industrial Network Management Software
Moxa Inc. All rights reserved 2014,

Service |1nﬁ, I

System Status:  Stop
¥ Connect to MXview with Built-in Browser

HTTP Port | [ Disable HTTP port smrt
HTTPS Port I Stop

Launch Client Sbop & Quit

3. Wait until the System Status field displays Running; then, clear the Connect to MXview with Built-in
Browser check box and click Launch Client.

M)(wew

Industrial Network Management Software
Moxa Inc. All nghts reserved 2014,

Service | Info

HTTPS Port I‘H.?r Stop I

I System Status:  Stop I
[~ iConnect to MXview with Builtin Browser;

HTTP Port |81 [~ Disable HTTF port Start | ‘

Stop & Quit

4. MXview opens Internet Explorer. Follow the on-screen instruction to configure Internet Explorer settings.
Click Next to continue.

. -~ ==l xJ

ARl - cobos |||

i} Favorites | {5 €| Web Slice Gallery =

|elnternetExplorercannotdi;playthewebpage | | & v > [ @ v Page~w Safety> Tools~ ®v

Set Up Windows Internet Explorer & u

U

Welcome to Internet Explorer 8

Internet Explorer 8 helps you use the Internet even faster than before.

New features like search suggestions retrieve information as you type,
and Accelerators let you preview online services just by pointing your
mouse at them.

Learn about these new features and how to manage their settings

Read the Internet Explorer Privacy Statement online

[ Next I ’ Ask me later

Done —— e — 100% -
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5. Select No, don’t turn on and click Next.

& Mitiew - Windows Internet Explorer

u U |g, http:/flocalhostd Lindex_en htrn
77 Favarites | = Suggested Sites > @ Web Slice Gallery =

& Mxview

~[ B[4 x][= s

- v [ o= v Pagev Safetyv Toolsw @~

Set Up Windours Internet Explorer 8

/=

i

Turn on Suggested Sites

yollve wisited?

Yes, turn on Suggested Sites

o, dor't turn o

Copyri
All g
Other |

weehsite suggestions. You can turn off Suggested

Read the Internet Explorer Privacy Staternent online

Do you want to discover websites you might like based on websites

Suggested Sites is an anline service that uses your browsing history to rmake personalized

@ are

Sites at any time,

[t (e ] [

€ Local intranet | Protected hode: Off

v H10% -

i

6. Select Use express settings and click Finish to complete the configuration.

& Mituiew - Windows Internet Explorer

uu ‘g, http:/Alocalhost:B1findex_en htm

57 Favorites | oY Suggested Sites v @) Wieb Slice Gallery »

- | B[4 x][E 8ing

& Mhview 5 - v [ g v Pagew afetyw Toosv (@
Set Up Mindows Internet Explorer & @ are
~
( Choose your settings
Before you get started, do you want to

Search provider: Bing

Search Updates: Download provider updates

Accelerators: Blog with Windours Live, Map with Bing, E-mail with Windows Live,

Translate with Bing
Capyii SmartScreen Filter: Enabled
All rig Cornpatibility Wiews Use updates
Other | )

I Choose custom settings
Review and modify each setting individually,
Read the Internet Explorer Privacy Staternent online [ Back ] [ By ] l Cancel

€& Local intranet | Protected Mode: Off
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7. Log in using the default username (admin). Leave the Password field blank. Then, click Login.

[ € Mxicw - Windows e el
’ 9 £ | http://localhost:81/index_en.htm hd @m E Bing P~
i Favorites | o) E Suggested Sites v @ | Web Slice Gallery +
‘@M)(vizw | | &~ v [ gm v Pagev Safety~v Toolsw @~
r@ Intranet settings are now turned off by default. Intranet settings are less secure than Internet settings. Click for options... x
Industrial Network Management Software
Username
admin
Visualize _ S
Industrial Ethernet Networks S i Operation Mode
||
@ Done € Internet | Protected Mode: Off vy H10% v J

8. A popup message appears prompting you to install Java Runtime Environment (JRE). Click OK.

£ http://localhost:81/index.htm#monitor

i Favorites | Y E Suggested Sites v @] Web Slice Gallery ~
\f_) http://localhost:81 findexhtm - v [ g v Pagev Safetyv Toolsv @~
@ Intranet settings are now turned off by default. Intranet settings are less secure than Internet settings. Click for options... X
7 B
Message from webpage u
ié You should refresh this page after successful install the JRE.
@ — e Internet | Protected Mode: Off da v 0% - p
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9. Click the title bar and select File Download Blocked > Download File.

‘& http://locall

€] http://localhost:81/index. htm#monitor v | B | 42 | % [IllS) 8ing

{} Favorites | {n‘g ESuggested Sites v @ | Web Slice Gallery =
| T« B - ] f= v Pagew Safety~ Tools~ @@~

| @ nttp://localhost81 findex htm

File Download Blocked 3 Download File... -
Intranet Settings 3 What's the Risk?
Information Bar Help |

€ Intemnet | Protected Mode: Off Fy v H100% v

@ Done

10. Select Run to download and install Java Runtime Environment.

((®

fasll €] htp://localhost1/indexhtm

{; Favorites | {E‘a E Suggested Sites v @ | Web Slice Gallery
|7| 5o - [ dm v Pagev Safetyv Tools~ @~

| & nitp:/Nocalhostel findexhim
@ Intranet settings are now turned off by default. Intranet settings are less secure than Internet settings. Click for options...

0% of jre-6u29-windows-15386-s.exe from localhost Com.. =

File Download - Security Warning

Do you want to run or save this file?

@ Name: jre-6u29-windows-i586-5.exe
Type: Application, 16 3MB
From: localhost

I Run ][ Save II Cancel I

patentially ham your computer. f you do not trust the source, do not

|@ While files from the Intemet can be useful, this file type can
run or save this software. What's the nsk?

& Internet | Protected Mode: Off va v

@ Done
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11.

Select Run to continue.

€| http://localhost:8]/index.htm

i} Favorites | {.;9 E Suggested Sites v @ | Web Slice Gallery =

| @ http:/flocalhosts1 findex htm [ ] % v B v 0 # v Pagev Safetyv Tools+ @~

Moxa SynMap Package

@ Intranet settings are now turned off by default, Intranet settings are less secure than Internet settings. Click for options... x

|

e
Internet Explorer - Security Waming 0

Do you want to run this software?

[E

( More options Run

| @

Name: Java(TM) SE Runtime Environment &.0 Update 23

Publisher: Sun Microsystems, Inc.

| [ ponithun |

While files from the Internet can be useful, this file type can potentially harm
your computer. Only run software from publishers you trust. What's the risk?

Open Folder

@ Done € Internet | Protected Mode: Off v H100% v

12. Click Install.

£ http://localhost:81/index.htm

5 Favorites | S E Suggested Sites » g&| Web Slice Gallery =

|| @ hitpy/localhostEL findexhtm [ ]

BN~ v 2 @& ~ Pagev Safetyr Tools~ @+

Intermek.caitinacClickfarani x
et cettina .
[ -

@Intranet settings are now turned offbwdefault Intranst cettina lecs cecice th
Java Setup - Welcome

ORACLE

Welcome to Java™

Jawva provides safe and secure access to the world of amazing Java content
From business solutions to helpful uiliies and entertainment. Java makes
wourinternet expetience come to life

MNote: No persanal information is gathered as part of our install process
Click here for more information on what we do collect

L Click Install to accept the license agreement and install Java now.

Cancel Install »

I~ Change destination foldsr

@ Done

& Internet | Protected Mode: Off 4 v H10% v
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13. Wait until Java installation is complete.

KBl ISl | hiip:/localhost&1 findexchtm M1 RN RS Bing

57 Favorites ‘ o) Suggested Sites » @] Web Slice Gallery

| @ nttp:/tocalhost81 findechtm [ %o~ v [ @ v Page~ Safetyv Tools~ @~
[# Intranet settings are now turned ommmwmmwm% x
Java Setup - Progress = J m

ORACLE’

Statuz  Instaling Java

3 Billion Devices Run Java

one nternet | Protecte ode: h{ 9 A
@ D I P d Mode: Off 100%

14. Click Close to complete the installation process.

| €| http://localhost:E1/index.htm

5 Favorites ‘ o Suggested Sites v @ | Web Slice Gallery +
| - v ] g v Pagev Safety~ Tools~ (@~

| @ nitp:/Nocalhosts1 findexntm

T L sk bkl T — X

- .
@' Intranet settings are now turned offlucdef = = e - ~

Java Setup - Complete

i

ORACLE

+/ You have successfully installed Java

Jawva updates will automatically be downloaded to provide you with the
latest features and security improverments.

To change this. see httplfjava. comfautoupdate

Close

@' Done & Internet | Protected Mode: Off v H100% v
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15. Click the message bar and select Enable Intranet Settings.

http://local

&) hittp://localhost&1 /index htm ~| & | 4| x [l[=] Bing

pv

77 Favorites | 9k [2] Suggested Sites » @] Web Slice Gallery ~

|| @ nttp/localhostsl /index htem ]

B~ v [ @ v Pagev Safetyv Toolsw @~

¥)) Intranet settings are now turned off by default. Intranet settings are less secure than Internet

Enable Intranet Settings
What are Intranet Settings?

Information Bar Help

Don't Show This Message Again

@ Done 0 Internet | Protected Mode: Off

‘&

-

#100%

-

16. Click Yes to continue.

€ calh

] http://localhost81/index.htm ~ | & [ 42| x [|[=) ging

n -

f:? Favorites | {;‘5 E Suggested Sites ¥ @ | Web Slice Gallery ~

|| @ rttpuiocalhostal findexhtm [ ] -8 -2 @ -

Page v Safety v Tools + @v

@ Intranet settings are now tumed off by default. Intranet settings are less secure than Internet settings. Click for options...

g »
Internet Explorer g

|’ Intranet settings use a less secure level than the Intemet.
you only go to Intemet websites, you should not tum on
intranet settings.

I Are you sure you wart to tum on intranetdeve! security

settings?

one nternet | Protected Mode:
W D I P d Mode: Off

a4

-

#,100%

-
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17. Click Run.

i ™
Warning - Security ﬁ

The application's digital signature cannot be verified. 0

Do you want to run the application?

Name: LT MxViewUI
Publisher: UNKMNOWN

From: http: /localhost:81

] &l

= This application will run with unrestricted access which may put
your personal information zt risk. Run this application onby if you More Informaticn...

- trust the publisher.

18. Click Next to launch the setup wizard to configure basic settings; otherwise, click Cancel to launch the
program immediately.

- — =

.
G5 Setup Wizard ==
r s - _

Welcome to the setup wizard.

This wizard will help you:

1. Add scan range
I 2. Draw Topology (with devices that support LLDP)
3. Set SNMP trap server

Mext ] ’ Cancel

| — =
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The MXview screen appears.

i Fovor ey
6 ipocalhosts1 indechtm v B - @ v Pager Sieyw Took @+

e Viw Deics Uk imaten Ewnl_Toos WB_ el
NXVIQW: el ictal Nisioris nigeunsn Soiissars MOXAN\
oo g 2
[ 2o Rocen s aetion iy Erats - [ O
Ack D Sot Source IP Device Alias. es Time Issued
g 0000 a0rsos0s 1815
g 8588 pER e
a P
e s Wanages Desces e a0 0120
G Localintranet | Protected Mode: Off v R -

Loading the Moxa SynMap MIB File

Follow these steps to load the Moxa SynMap MIB file.

1. Double-click the MxView Service icon on the desktop.

2. Click Start.

MXwe.w

Industrial Network Management Software
Moxa Inc. All nghis reserved 2014,

Service IInfo I

System Status: Stop
[¥ Connect to M¥view with Built-in Browser

HTTP Port | [ Disable HTTP port Siart
HTTPS Port | Stop

Launch Client Stop & Quit
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3. Wait until the System Status field changes to Running; then, click Launch Client to continue.

MXview
L CFFE 'ndustrial Network Management Software
Maoxa Inc. All ights reserved 2014,

Service |InFo I

HTTP Part 81 [T Disable HTTP port Stark |
HIPs port | 443 Stop |

System Status: Running
w Connect to MXview with Built4n Browser

oK I I Launch Client |I Stop & Quit

4. Click Cancel.

Welcome to the setup wizard.

This wizard will help you:
1. Add scan range

| 2. Draw Topology (with devices that support LLDP)
3. Set SNMP trap server

Mext

) |

Cancel
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5. Select MIB > MIB Browser.

e
<. DIErs finde R B 7o
¢ Favorites | ¢, [2] Suggested Sites > ] Web Slice Gallery
| @ hitpi/flocalhost &1 /indexchtm |7| - - [ @ v Pagev Safetyv Tookw @~
Project View Device Link Information Eveni Tools | MIB | Help -

. | MIB Browser
NOCVI@W. 5165620 155056 5] 0 anager ) P4\

Trap Import Manager

Device List
' Root
g
No Message 11:37:27PM Managed Devices (CurrentMax) :0/20

€ Local intranet | Protected Mode: Off 43~ ®00% -

6. In the MIB Browser window, select File > Load MIB.

Py
I €] http:/flocalhost L findechtm

i Favorites | . =) Suggested Sites v ] Web Sice Gallery +

| @ http:/localhost81/indexhtm 1 &~ ~ [ d v Pagev Safety~ Tools~ @~
Project View Device Link Information Event Tools MIB Help "
MXview susf e S A o)
Load Wig
pevcalled L oo [ ]
= Root SIS
= Get | [ cetNex || Getsusree |[ wak ][ set
Name/OID Vaiue
No Message | ]]:ﬂﬂ#l
°ii

Done € Local intranet | Protected Mode: Off 45~ ®0% -
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7. Go to c:\usr\share\snmp\mibs\ and select MOXA-SYS-MIB.txt; then, click Open.
T

— &

i Favorites | ¢ [5) Suggested Sites v ] Web Sice Gallery

| @ hitp/flacalhost31 indeshtm ] B~ v [ g v Pagev Safetyv Toolsv (@~

Project View Device Link Information Event Tools MIB Help =

> [o/®] = |
£ MIB Browser A

.
MXview L -
File:
AgentlP 127.0.0.1

| RFC1213-MIB
Q- Search Devices .

Device List © Open - ﬂ
% Root
Lookin: | . mibs - FeE@E set
D || IANA-LANGUAGE-MIB IIEmE! !
) | 1ANA-RTPROTO-MIB [ mTA-MB
Recentttems | IANAifType-MIB L] NET-SNMP-AGENT-MIB
|_| IF-INVERTED-STACK-MIE || NET-SNMP-EXAMPLES-MIB
o LFMB | NET-SNMP-EXTEND-MIB
| | | | INET-ADDRESS-MIB [ NET-SNMP-MIB
Desktop | IP-FORWARD-MIB | NET-SNMP-MONITOR-MIB
[ 1p-mB [ NET-SNMP-PASS-MIB
= | IPV6-FLOW-LABEL-MIB || NET-SNMP-PERIODIC-NOTIFV-MIE
{‘\ |1 1pv6-1cMP-MIB [ NET-SNMP-SYSTEM-MIB
My Documents | | IPV6-MIB L NET-SNMP-TC
|| IPV6-TC || NET-SNMP-VACM-MIE
iy brerewe | NETWORK-SERVICES-MIB
= || 1pVe-UDP-MB || NOTIFICATION-LOG-MIB
Computer || LM-SENSORS-MIE | RFC-1215
‘ i v
Mo pomiB
MWk fies oftype: [l ries =
No Message 11:38:15 |
0 i
Done €& Local intranet | Protected Mode: Off

8. In the MIB Browser screen, verify that the MOXA-SYS-MIB folder displays in the File list.

LY MIBE Browser |F|E-|g
File
RFC1213-MIB
rm AgentlP  127.0.0.1
oD
Get | [ cetwex || cetsuomee ||  wak || Set
Name/OID Value
i {l
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Loading the Host Resource MIB File

Complete the following steps to load the Host Resource MIB file.

1. Double-click the MxView Service shortcut on the desktop.

2. Click Start.

MXview

LT 'ndustrial Network Management Software
Moxa Inc. All nghis reserved 2014,

Service IInfo I

HTTP Port | [ Disable HTTP port Siart
HTTPS Port | Stop

System Status: Stop
[¥ Connect to M¥view with Built-in Browser

Launch Client 5to|:| & Quit

3. Wait until the System Status field becomes Running; then, click Launch Client.

MXwew

Industrial Network Management Software
Moxa Inc. All nghts reserved 2014,

Service Ilnﬂ, I

HTTP Port | 81 [T Disable HTTP port Start |
HTTPS Port 443 |

Systern Status:  Running
w Connect to MXview with Built4n Browser

oK I I Launch Client |I Stop & Quit I
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4. Click Cancel.

[ - - — -
4l Setup Wizard ﬂ

Welcome to the setup wizard.

This wizard will help you:
1. Add scan range

i 2. Draw Topology (with devices that support LLDP)
3. Set SNMP trap server

Mext ] ’ Cancel

'I: 3
5. Select MIB > MIB Browser.

localhost31/index htm

i Favorites | . =) Suggested Sites v ] Web Sice Gallery +

| & nitpy//localhost81 /indexhtm ] - ~ [ @ v Pagev Safety~ Took~ @~

Project View Device Link Information Event Tools | MIB | Help -

- MIB Browser
MNOXVIGW  liltsinal N8035 | op importnansger DX /\

Trap Import Manager

Qi Search Devices
Device List
< Root
B v
No Message 1:37:27PM Wanaged Devices (Current/ Max) : 0/20

G Local intranet | Protected Mode: Off

e = L)
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6. In the MIB Browser window, select File > Load MIB.

&) http://localhost8l findechtm

o~

[ v [ d® v Pagev Safetyv Tookv @~

¢ Favorites | ¢, [2] Suggested Sites > ] Web Slice Gallery
| @ hitpi/flocalhost &1 /indexchtm |7|
Project View Device Link Information Eveni Tools MB Help
- N A =)
Load MIB
I AgentiP 127,001 [ swenr ]
mlos
anguage
' Root
= Get | [ cenex || cetsuree |[  wak |[ s
Name/oID value
No Message a2l |
. e u __C\Dse

1. <« Local Disk (C) » usr » share » snmp » mibs

€ Local intranet | Protected Mode: Off

HOST-RESOURCES-MIB Date modified: 10/9/2012 3:28 PM
Text Document Size: 51.3 KB

Date created: 10/9/2012 3:28 PM

—— = —
I Organize » E Open - Print Mew folder

St Favorites Name . Date modified Type Size
Bl Desktop || AGENTX-MIB 10/9/2012 3:28 PM  Text Document 18 KB
& Downloads | BRIDGE-MIB 10/9/2012 3:28 PM  Text Document 50 KB
5] Recent Places || DISMAN-EVENT-MIB 10/9/2012 3:28 PM  Text Document 67 KB
|| DISMAN-EXPRESSION-MIB 10/9/2012 3:28 PM  Text Document 42 KB
4 Libraries || DISMAN-NSLOOKUP-MIB 10/9/2012 3:28 PM  Text Document 19 KB
[ Documents || DISMAN-PING-MIB 10/9/2012 3:28 PM  Text Document 56 KB
o Music || DISMAN-SCHEDULE-MIB 10/9/2012 3:28 PM  Text Document 25KB
[E5] Pictures || DISMAN-SCRIPT-MIB 10/9/2012 3:28 PM  Text Document 63 KB
B2 Videos || DISMAN-TRACERQUTE-MIB 10/9/2012 3:28 PM  Text Document 68 KB
| EtherLike-MIB 10/9/2012 2:28 PM  Text Docurment 83 KB
18 Computer | HCNUM-TC 10/9/2012 3:28 PM  Text Document 5KB
|_| HOST-RESOURCES-MIB 10/9/2012 3:28 PM  Text Document 52 KB
€ Network || HOST-RESQURCES-TYPES 10/9/2012 3:28 PM  Text Document 11 KB
|| JANA-ADDRESS-FAMILY-NUMBERS-MIB 10/9/2012 3:28 PM  Text Document 5KB
| IANAifType-MIB 10/9/2012 2:28 PM  Text Docurment 32KB
| JANA-LANGUAGE-MIB 10/9/2012 3:28 PM  Text Document 5KB
|| JANA-RTPROTO-MIB 10/9/2012 3:28 PM  Text Document 4KB

< I ] »
B
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8.

In the MIB Browser screen, verify that the HOST-RESOURCES-MIB folder appears in the File list.

r
L£¥ MIB Browser

PEY =

File

, RFC1213-MIB
i

Agent P 127.0.0.1

SNME w1

e oD
host (25)

| haMIBAdminInta (7) Get Next Walk

J|

” Get Sublree H

I

o huBystern (1)

, hediorage (2)

o huDevice (3)

) b WRun (4)

) b WRunPerf (5)
) e Wnstalled. (&)

Value

name
01D
description

HOST-RESOURCES-MIE

Q@ 9u

Close

Using Moxa SynMap OIDs

Complete the following steps to use Moxa SynMap OIDs:

1.

Check the UART type. Navigate to

MOXA-SYS-MIB\VALUES\moxa\embeddedComputer\moxaSystem\peripheralMgmt\ and

double-click uartConfigTable.
Click Get Subtree and verify that your MxView settings are correct.

LY MIB Browser

B - 0
File
. RFC1213-MIB
| MOXA-5YS-MIB AgentIP 127.0.01 SMMP w1
= |l VALUES
1) moxa (3691) oID 1.3.6.1.4.1,8691.17.1.6.3.2.1.2.4
= i embeddedComputer {17)
[ | moxaSystem (1) Walk ] ’ Set
|, productInfoMgmt (1)
. biosMgmt ()
N 1D Val
, sensorMgmt (5) S e
peripheralMgmt (&) uartindex. 1 1
| perloMgmt (1) uartindex, 2 2
| perLedMgmt (2) uartindex. 3 3
perSerialMgmt (3) uartindex. 4 4
W uartiumber (1) uartType. 1 0
- uartType.2 0
. perUsbMgmt (4) uartType.3 0
|| notificationMgmt (3) uartType. 4 0
| . HOST-RESOURCES-MIB
] [ G
name uartConfigTable (2} <
ol 1.3.6.1.4.1.8691.17.1.63.2
SEQUENCE OF SEQUENCE [ua
ta rtindex INTEGER {-2147483848. | =
- 2147483647, uartType INTEG
ER]
SCCESS not-accessible | 1
VALUE uartConfigTable OBJEC
T-TYPE {
Syntax: SEQUENCE OF SEQU
EMCE [uartindex INTEGER (-21 - - W
4T482848. 21474826847), vartTy| - @ a 1y
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Using HOST RESOURCE OIDs

Complete the following steps to use HOST RESOURCE OIDs.

1. Check disk usage. Navigate to HOST-RESOURCES-MIB\VALUES\host\hrStorage\hrStorageTable\
and double-click hrStorageEntry.

2. Click Get Subtree and verify that your MxView settings are correct.

LY MIE Browser
File
. RFC1213-MIB
MOXA-5YS-MIB AgentIP 127.0.01 SNMP w1
B- Jy VALUES
. HOST-RESOURCES-MIE QD 136.1.21.2523.1.7.3
=) VALUES p—
54 host (25) cet | [ cethen CetSuptrae N wak | set
hrMIBAdminInfo (7) | |
hrSystem (1)
5 hrstorage (2) Name/OID Value
[ hrStorageTypes (1) hrStoragelndex. 1 1
b W hrMemarySize (2) hrStorageIndex. 2 2
- hrStorageTable (3) hrStoragelndex. 3 3
E| hrStorageEntry (1) hrStorageType. 1 1.3.6.1.2.1.25.2.1.4
b hrStorageType. 2 1.3.6.1.2.1.25.2.1.3
hrStorageType. 3 1.3.6.1.2.1.25.2.1.2
W) hrStorageDeser (3) hrStorageDescr. 1 IC:\Label: Serial Mumber 6607fe31
W), hrStorageAllocationUnits (4) hrStorageDescr.2 Wirtual Memory
“f hrStorageSize (5) hrStorageDescr. 3 Physical Memory
W) hrstorageUsed (5) hrstorageAllocationUnits, 1 4096
W) hrStorageAllocationFailures (7) hrStorageAllocationUnits. 2 65536
hrDevice (3) hrStorageAllocationUnits. 3 65536
hrSWRuN (4) hrStorageSize. 1 3833519
hrSWRunPerf (5) hrStorageSize. 2 64200
hrSWinstalled (5) hrStoragesSize. 3 64229
hrStoragelsed. 1 3502447
hrStorageUsed. 2 24224
s . hrStoragelsed. 3 22116
oD = v (1) 2 hrStorageAllocationFailures. 1 (o]
13082 11352 54 hrStorageAllocationFailures, 2 ]
QUENC SER (2
?53“‘3:?:“;5‘;2:;:2;‘"“’( \NTE?ER \C‘);j hrStorageAllocationFailures. 3 o
o vee =
ECT IDENTIFIER, hrStorageDescr OCTET S
TRING [SIZE {0..255)), hrStorageAllocationU
nits INTEGER {-2147483848..2147483847), |
hrStorsgeSize INTEGER (-2147483848. 214
74B2847), hrStorageUsed INTEGER {-21474
syntax | B3848..214748847), hrStorageAllocationFa
ilures INTEGER (0. 4254987295)]

@ 8

Retrieve the value of hrStorageAllocationUnits.1 (for example, 4096).

4. Retrieve the value of hrStorageSize.1 (for example, 14384127).

Calculate the total disk size using the following formula:
total disk size = hrStorageAllocationUnits x hrStorageSize

In this example, the total disk size is 4096 x 14384127= 58917384192 = 54.9 GB
6. Check memory usage. Go to the HOST-RESOURCES-MIB\VALUES\host\hrStorage\ folder and
double-click hrMemorySize.
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7. Click Get.
LY MIE Browser — - - - = =]
File
| RFC1213-MIB
. MOXASYS-MIE AgentlP  [127.0.0.1
| HOST-RESOURCES-MIB
= b VALUES oD 1.3.6.1.2.1.25.2.2.0
= |} host (25)
- | hrMIBAdminInfo (7) ICet || cetNew || cetsuotee |[  wak | [ set
. hrSystem (1)
. hrStorage (2)
@ hrStorageTypes (1) Mame,OID Value
S Yhrviemarysize (2) hrMemarySize |4110700

- hrStorageTable (3)
. hrDevice (3)

. hrswRun (4)

. hr3wRunPerf (5)

. hrswinstalled (6)

name hriemaorySize (2} -
o 1.3.6.1.2.1.252.2 [
syntax INTEGER {0..2147483847)
SCCess read-only
WVALUE hrfdemorySize OBJECT-
TYFE |

Syntax: INTEGER {0..2147483
847)

Units: KBytes

Access: read-only

Status: cument L

Description: The amount of ph o
ysical read-write main memory, 'Qﬁ" a i
typically RAM, contain| 7 |

h -

m

description

8. You can also check the physical memory size using Windows Task Manager.

|58 Windows Task M

File QOptions View Help
|Applicaﬁons I Processes I Services | Performance | Networking I sers |
CPU Usage CPU Usage History
Memary Physical Memory Usage History
Physical Memory (MB) System
Total 2728 Handles 13454
Cached 162 Threads 704
Available 2116 Processes 59
Free 1977 Up Time 0:00:03:34
Commit (MB) 721/ 2726
kernel Memory (MEB)
Paged a7 : :
Monpaged g8 | Resource Monitor. .., |
Processes: 59 CPU Usage: 1% Physical Memory: 22%

9. Check disk usage. Go to the HOST-RESOURCES-MIB\VALUES\host\hrDevice\hrProcessorTable\
folder and double-click hrProcessorEntry.
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10. Click Get Subtree.

-
L MIB Browser -

File

, RFC1213-MIB

. MOXA-5YS-MIB

, HOST-RESOURCES-MIB
= | VALUES

- )} host (25)
, hrMIBAdminInfo (7)
| hrSystem (1)
) hrstorage (2)
) hrDevice (3)
- 4 hrDeviceTypes (1)
-] hrDeviceTable (2)
=[] hrProcessorTable (3)
B
&, hrProcessorFrwIC
*-- @), hrProcessorLoad |

7 hrietworkTable (4)

[T hrPrinterTable (5)
[T hrDiskStorageTable (6)
-] hrPartitionTable (7)

- @ hrFSTypes (3)
.1 heFSTahle 1Y
1 | +

Agent IP 127001

oID 1.3.6.1.2.1.25.3.3.1.2.4

Get

J|

Get Mext

| | GetSuptree ||  walk Set

Mame/OID
hrProcessorFrwiD. 3

Value
0.0

hrProcessarFrwiD. 4

0.0

hrProcessorLoad. 3

k]

hrProcessorLoad. 4

9

name
CID

hrProcessorEntry {1)
1.3.6.1.2.1.25.3.3.1

SEQUENCE [hrProcessorFrwlD

OB.JECT IDENTIFIER, hrProcess
syntax

.2147483647)]

access not-sccessible

WALUE hrProcesscrEntry OBJEC
T-TYPE {

Syntax: SEQUENCE [hrProcess
orFrwlD OBJECT IDENTIFIER, h
rProcessorLoad INTEGER (-214

7483848, 214T4B2847)]

orload INTEGER (-2147483648 ||

Close

h

@ ¢

11.

Options  Wiew Help

|Applimﬁons I Processes I Services | Performance | Networking I sers |

CPU Usage CPU Usage History

Memary Physical Memory Usage History

Physical Memory (MB) System

Total 2728 Handles 13454

Cached 162 Threads 704

Available 2116 Processes 59

Free 1977 Up Time 0:00:03:34
Commit (MB) 721/ 2726

Kernel Memory (MB)

Paged a7

Monpaged 68 Resource Monitor. . |

You can also check the CPU loading of each CPU core using Windows Task Manager.

Processes: 59 CPU Usage: 1%

Physical Memory: 22%
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Examples

This chapter provides examples to illustrate how to use the V2406A computer for a variety of applications.
The following topics are covered in this chapter:

O SerialInterface
O Digital Input/Output
0 Watchdog
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Seriallnterface

1. Copy the following files from the product software DVD.
mxsp.dll: \examples\V2406A_W7E_V1.0_example\lib\mxsp\x86\
sysinfo.dll: \examples\V2406A_W7E_V1.0_example\lib\mxsp\x86\
sysinfo.sys: \examples\V2406A_W7E_V1.0_example\lib\mxsp\x86\
mxGenerallo.dll: \examples\V2406A_W7E_V1.0_example\lib\MxGenerallo\x86\
Seriallnterface.exe: \examples\V2406A_W7E_V1.0_example\Release\

2. Execute Seriallnterface.exe.

Bl Administrator CAWindowstsystem32hcmd exe - Seriallnterface.exe o || B e

C=~Sample*Seriallnterface.exe

Serial Interface Test Program
(@) Exit Program
(1> Display Serial Interface
(2> Set Serial Interface

3. Type 2 to set the serial interface. Follow the on-screen instructions.

| C\Sample\Seriallnterface.exe |£|E|i‘]

Serial Interface Test Program
(@) Exit Program
(1> Di=splay Serial Interface
(2> Set Serial Interface

m| »

2
Input the Port Humber (1 ™ 4> =
1

Input the value (@:RS§232. 1:RS485-2l), 2:R8422 3:R8485-4Y )
Set serial interface success?
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4. Type 1 to display the current serial interface settings.

# | CASample\Seriallnterface.exe |£|E|i-J

Serial Interface Test Program
(@) Exit Progra
(1> Display Serial Interface
(2> Set Serial Interface

RS485-2U
R5232
R5232
RS232

Digital Input/Output

1. Copy the following files from the product software DVD.
mxdgio.dll: \examples\V2406A_W7E_V1.0_example\lib\mxdgio\x86\
mxGenerallo.dll: \examples\V2406A_W7E_V1.0_example\lib\MxGenerallo\x86\
DIO.exe: \examples\V2406A_W7E_V1.0_example\Release\

2. Execute DIO.exe.

B Administrator: Command Prompt - dio o] @ ==

IC:\Sample >dio
UART Mode Test Program
Exit Program
Display DIN
Display DOUT
Set DOUT wvalue
Display both DIN and DOUT

3. Type 4 to display the current DI and DO values.

BE¥ Administrator Command Prompt - dia =0EE @

iC=“Sample *dio
UART Hode Test Program
(B> Exit Program
1> Display DIN
(2> Display DOUT
(3> Set DOUT value
¢4> Display hoth DIN and DOUT

DoutB 1

Doutl i

4, Type 3 to set the DOUT port number. Follow the on-screen instructions.
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EX Administrator: Command Prampt - dio =0 Ea @

C=~Sample *dio
UART Mode Test Program
(@> Exit Program
Display DIN
Display DOUT
Set DOUT value
Dizplay both DIN and DOUT

3
énput the Port Mumber <8 ™ 1> =

Input the value <8 or 1> = 8
Let digital output successt?

5. Type 4 to check if the port value was set correctly.

B Administrator Command Prampt - dio === @

C:~Sample>dio
UART Mode Test Program
{@> Exit Program
(1> Dizplay DIN
(2> Dizplay DOUT
(3> Set DOUT walue
4> Display both DIN and DOUT

» DoutB@ a
» Doutl =1

Watchdog

1. From the product software DVD, copy the following files:
e mxdev.dll: \examples\V2406A_W7E_V1.0_example\lib\mxwdg\x86\
e mxGenerallo.dll: \examples\V2406A_W7E_V1.0_example\lib\MxGenerallo\x86\
e Watchdog.exe: \examples\V2406A_W7E_V1.0_example\Release\

2. To prevent the system from rebooting, press [Enter] at least once every 10 seconds; otherwise, the system
will reboot automatically.

3. To stop the watchdog, press q to exit the program

B Administrator: C ows\system32\cmd. u&I_J

D:=~J>watchdog
"ENTER" i seconds
to exit
"ENTER" i seconds
to exit
"ENTER" i seconds
to exit
"ENTER" i seconds
to exit
"ENTER" i seconds
to exit
"ENTER" i seconds

m

o]
=
=0

LI = I = = e = = Y = L = I =)

to exit

"ENTER" i seconds
to exit

"ENTER" i seconds
to exit

"ENTER" i seconds
to exitqg

-0 W =0 = W =0 = -
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System Recovery

This chapter describes the system recovery process that you can perform if the system is not functioning
properly.

The following topics are covered in this chapter:

a
a
a

Overview

Setting Up the Recovery Environment

Setting Up a Factory Default Recovery Image

>
>
>
>

Step 1:
Step 2:
Step 3:
Step 4:

Prepare the USB drive

Setting the BIOS to Boot via USB
How to Perform a System Recovery
Reset the BIOS to its Original State

Creating a Custom System Image
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Overview

This section describes how to prepare your computer for recovery in the event the system becomes unstable.
You can perform a system recovery using one of the following system images:

e A clean factory default image.
e A user-generated image created from a fully configured, fully set up system.

Before you perform a system recovery, set up the system environment.

Setting Up the Recovery Environment

To set up the recovery environment on a V2406A computer, prepare a USB drive that has at least 4 GB of
memory and a copy of the recovery suite.

The following lists the major steps in the recovery procedure:

1. Copy the recovery programs and system image file on to the USB drive. Set up the drive as a live-drive
system with an ISO image of the boot environment.

2. Reboot the system and configure the BIOS to boot the recovery system from the USB port.

An image of the current software system will be created on the USB drive. The recovery environment will
use this image when restoring the system.

4, Reboot the system again and the BIOS is returned to its original state.

Setting Up a Factory Default Recovery Image

Step 1: Preparing the USB drive

1. Load the software DVD that came with your V2406A computer and execute tuxboot-windows-23.exe in
the \recovery\ folder.

2. Select Pre Downloaded and click the ellipsis (...) button to browse the file system and locate the boot
environment’s ISO image.

M Tuxboot s X

i) On-Line Distribution | donezilla_live_stable [s| lcurrent v Update

S C'IJTIIIL.‘.'-’..I"":;
Homepage: http://conezila.orgf
Description: Clonedilla live is a distribution used For disk backup and imaaing. The stable branch of Clonezilla live
are based on Debian
Install Motes: CloneZilla live is booted and run in live mode; no installation is required to use it,
Download Path: Clonezila Live Stable at SourceForge

) Pre Downloaded 150 [ 2| I E

[] show all Drives (Use with Cared  [] Save IS0 file MDS Check,

Type: USE Drive __V.: Crive: [FiY v I (]9 H Cancel I
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System Recovery

3. Navigate to the \recovery\ folder on the software DVD and select the boot environment’s ISO image.

Organize * Share with = New folder
W Favorites Rams
Bl Desktop 0s_image
4. Downloads I &4 clonezilla-live-2.0.1-15-i686-pae-moxa-2.0.6

12| Recent Places - tuxboot-windows-23
. Libraries

3 Documents

& Music

=] Pictures

E Videos

Date modified

12/24/201412:03 ...
7/18/2014 9:43 AM
5/26/2011 8:33 PM

Type

File folder
Disc Image File

Application

Size

107,072 KB
5729 KB

4. Select USB Drive from the Type drop-down list and select the drive letter that corresponds to the USB
drive from the Drive drop-down list. Click OK to copy the boot environment and bootloader to your USB

drive.

M Tuxboot

i) On-Line Distribution | clonezilla_live_stable

o —

Ve Clonezilla
Homepage: http://conezila.orgf

are based on Debian

Download Path: Clonezila Live Stable at SourceForge

(*) Pre Downloaded 150

[] show all Drives (Use with Cared  [] Save IS0 file

[% current

Description: Clonedilla live is a distribution used For disk backup and imaaing. The stable branch of Clonezilla live

Install Motes: CloneZilla live is booted and run in live mode; no installation is required to use it,

[w} | [:12011-06-15-13 clonezilla-live-1.2. 8-46-i686.is0

MDS Check

'V pdate

I

|I Type: USE Drive ?_V.IDrige: Fil :V'II (4 J I Cancel I
5. Click Exit.
M Tuxboot e Z

1. Dawnloading Files (Done)

2. Extracting and Copying Files (Done)

3. Installing Bootloader {Done)

4. Installation Complete, Reboot {(Current)

After rebooting, select the USE boot option in the BIOS boot menu.
Reboot now?

Reboot Mow

||

Exit
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6. From the desktop, copy the directory containing the base OS from the software DVD on to the USB drive.
That is, copy #:\<SoftwareDVD>\recovery\os_image to the partition image directory,
F:\home\partimag\, on the USB drive.

However, if you want to recover from your own system image, back up a system image first. For more
information, refer to the Creating a Custom System Image section.

After Step 1 procedure is complete, proceed to the next section, Step 2: Setting the BIOS to Boot via USB.

€9 BT
g_@ [« NEWVOLUME(D:) » home » partimag »

Organize = A Open Share with + Mew folder =~ [ ﬂ
-
- \ ifi » Siz
% Favorites Name Date meodified Type Siz]
Bl Desktop os_image 6/15/2014 5:58 PM  File folder

& Downloads

°| Recent Places

7 Libraries

=| Documents

m

@' Music
k| Pictures

B8 videos

M Computer
&, Local Disk (C)
= NEW VOLUME (C

f:i.i Metwork
~ |4 1 3

os_image Date maodified: 6/15/2014 %58 PM
File folder

Step 2: Setting the BIOS to Boot via USB

This step shows you how to reset the BIOS so the system can boot directly from the USB port. You must
perform this action before you can continue to configure the system recovery environment.

1. Reboot the system, and, during the POST process, press F2 until you hear a long beep. Click SCU to enter
the BIOS setup menu.

Boot From File

2. Use the left and right arrow keys to navigate to the Boot menu.

3. Use the up and down arrow keys to navigate to the Legacy field; then, press [Enter].
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rLegacy

F5/F6
Enter

4. Use the up and down arrow keys to navigate to the Boot Type Order link; then, press [Enter].

MBoot Type Order

F5/F6
Enter

5. Use the up and down arrow keys to navigate to the USB link; then, use the plus or minus (+/-) key to move
USB to the top of boot priority list.
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F5/F6
Enter

6. Press F10 and [Enter] to save and exit the BIOS configuration interface. This sets the system to reboot from
the hard drive.

Step 3: Performing a System Recovery

This step describes how to perform a system recovery. We include this as step 3 of the installation so
administrators can first perform a test run before deploying the system to the field.

To begin the system recovery process, configure the BIOS settings as described in the previous section Step
2: Setting the BIOS to Boot via USB. Then, connect the USB recovery drive to any USB ports on the V2406A
and then reboot the computer. If you have successfully prepared the USB and BIOS, the computer will boot into
the Clonezilla boot loader from the USB port.

1. Select clonezilla live restore disk to boot into the system recovery environment.

wstem Save & Restore Utility (U1.B.8)

2. Wait until the boot process is finished.
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.153522]1 =d 0:0:0:0: [sdal Attached 3CSI disk

.1637261 =4 0:0 ¢ [sdb] Attached 3CSI disk

.£2879411 i : Attached scsi generic =g0 type O

.3107501 " ! Attached sc=si generic =gl type O

.334915]1 =r 1:0:0:0: Attached scsi generic =g2 type 5

! Loading essential drivers ... [ 5.690577]1 Atheros(R) LZ Ethernet Driver - version 2.2.3
6924301 Copyright (c) 2007 Atheros Corporatiom.

7767701 Broadcom NetXtreme II 5771x 10Gigabit Ethernet Driver bnxZx 1.62.00-6 (2011-01.30)
.9140141 Btrfs loaded

.955475] device-mapper: uevent: version 1.0.3

.961407] device-mapper: ioctl: 4.19.1-ioctl (2011-01-07) initialized: dm—devel@redhat.con

: Rumming sscriptssinit-premount ... done.
! Mounting root file system ... [ 6.1789461 Uniform Multi-Flatform E-IDE driver
.1861891 ide_generic: please use "probe_mask=0x3f" module parameter for probing all legacy ISAH
IDE ports
6.913744]1 FAT: utf8 i= not a recommended I0 charset for FAT filesystems, filesystem will be cas
e sensitivet
.0479971 aufs: module is from the staging directory, the quality is unknown, you have been war

0725161 aufs 2.1-standalone.tree-38-rcN-20110Z28

! Running sscripts~slive-premount ... done.

.2134331 loop: module loaded

5097701 squashfs: version 4.0 (Z2009-01-31) Phillip Lougher

! Runming /scripts~live-realpremount ... done.

: Mounting “~livesimagesliversfilesystem.squashfs"” on "/sfilesysten.squashfs” via “sdeuvsloopd" .

Begin: Rumning sscripts-slive-botton
. Begin: Configuring fstab ... done.

[Begin: Preconfiguring networking ... done.
Begin: Loading preseed file ... done.
Begin: Runming sscriptssinit-bottom ... done.

INIT: version 2.88 booting

zing makefile-style concurrent boot in runlevel 3.

live-config: hostname user-setup sudo locales tzdata keyboard-comfiguration sysuinit sysu-rc initran
fs—tools util-linux login openssh-server_

3. The screen displays warning messages to remind you that you are about to overwrite your entire operating
system with a new drive image, and ask you if you want to continue. When prompted, enter Y (case
insensitive) to start the system recovery process.

You can press any key or [Ctrl + C] to cancel the recovery process and exit Clonezilla.

RITTEN! ALL EXISTING DATA WILL

a HARDDISK_ ¥
ORI oIk

4. The screen displays another warning message to remind you that you are about to overwrite your hard
drive and erase all data on the partition listed (sdal, in the following figure). If you want to continue, enter
Y (case insensitive).
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e hard partition(s) on this machine: "/

WILL BE OVERWRITTEN! ALL EX ING DATA HWILL

5. Wait until the process is finished.

Partclone
Partclone w0.2.23 http://partclone.org

Starting to restore image (-) to device (s/dev/sdail)
Calculating bitmap... Please wait... done!

File system: NTFS

Device size: 2.1 GB

Space in use: 1.7 GB

Free Space: 325.4 MB

Block size: 2048 Byte

Used block : B49156

Elapsed: 00:00:42
Remaining: 00:04:03
Rate: Jec.11MB/min

6. To complete the recovery process, select (0) Power off to shut down the computer. However, if the Power
Switch remains inserted in the front panel of the computer and is left in the ON position, the system will
not shut down and will immediately initiate a soft reboot. To avoid this, use the switch to cut off power to
the computer immediately following the shutdown command, or simply the power switch from the front
panel and use the console to shut down the computer by pressing 0.
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. tane!

r hoot mana or-the file

ip notifying it the jo

7. After the computer is powered down, remove the USB drive and store it in a secure place.

Step 4: Resetting the BIOS

Reset the boot priority to the factory default settings to allow the system to boot from the main system storage
drive. This is done for two reasons:

e The first reason is for security, since the computer will not be able to be rebooted from unauthorized USB
drives.

e The second reason is because the computer is able to boot up from a non-bootable USB drive. Currently, if
the V2406A is set to boot from a USB drive, the V2406A’s boot process stops anytime you insert a
non-bootable USB data drive into the machine. The V2406A cannot detect USB data drives and
boot-capable OS drives.

Complete the following steps to reset the boot priority setting:

1. Reboot the system, and, during the POST process, press F2 until you hear a long beep. Click SCU to enter
the BIOS setup menu.

Boot From File

2. Use the left and right arrow keys to navigate to the Boot menu.
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3. Use the up and down arrows to navigate to the Legacy link; then, press [Enter].

FlLegacy

4. Use the up and down arrow keys to navigate to the Boot Type Order link; then, press Enter.

»Hoot Type Order

F5/F6
Enter

5. Use the up and down arrows to highlight Hard Disk Drive and use the plus or minus (+/-) key to move
Hard Disk Drive to the top of the boot priority list.
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Boot Type Order

CD/DVD-ROH Drive
Others

6. Press F10 and [Enter] to save and exit the BIOS configuration interface. This sets the system to reboot, and
the system should now boot from the hard drive.

For more information about initializing user settings, refer to the System Initialization chapter.

Creating a Custom System Image

In this section, we describe how to create a custom system image so that all of your applications can be kept
and recovered. Using this procedure, you will save to the USB drive a copy of the entire system as it is
currently configured, and to be used as a full system recovery image if the system crashes. All files
under F:\home\partimag\ will be overwritten.

Before proceeding, make sure you have already completed Step 1: Prepare the USB drive and Step 2:
Setting the BIOS to Boot via USB, and then continue with the following steps to create a custom system
image.

1. Once the system has launched and the V2406A has booted the recovery environment from the USB drive,
navigate to clonezilla live save disk, and then select it by pressing Enter. This will take you into the
recovery image creation environment, allowing you to copy your full system setup to the USB drive.

Moxa System Save & Restore Utility (U1.8.8)

clonezilla live restore disk

clonezilla live =zave disk

Memtest & FreeD0S >

2. The V2406A boots into the image creation environment. Wait until the boot process is complete.
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.1419411
2572771
.2696911 =
2806681
: Loading
.7745611
.8631961
0059321
0540951
0597371

: Bunming

! Mounting root file system ... [

3018891
IDE ports
6.8011411
6.9142951
[Begin: Runmning
[ ?.3319891
e =zensitive!t
?.4533691
ned .
7.4790981
7.6102281
7.9051441
Begin: Rumning
Begin:

[Begin:

. Begin:
[Begin:
[Begin:
Begin:

Running

Loading
Runn ing

Hounting “~liverimage-livesfilesystem.squashfs" on

Configuring fstab ...
Preconfiguring networking ...

[sdb]l Attached SCSI disk
! Attached scsi generic sg@ type O

:0: fAttached scsi generic sgl type 0
sr 1! 0 0 0: Attached scsi generic =g2 type 5
essential drivers ... [ 5.7725511 fAtheros(R) LZ Ethernet Driver — version 2.2.3
Copyright (c) 2007 fAtheros Corporation.
Broadcom NetXtreme II 5771x 10Gigabit Ethernet Driver bnxZdx 1.62.00-6 (2011.01.30)
Btrfz loaded
device-napper:
device—mapper:

uevent: version 1.9.3
ioctl: 4.19.1-ioctl (2011-01-07) initialised: dm-devel@redhat.com

done.
6.2893821 Uniform Multi-FPlatform E-IDE driver

»scriptssinit-premount ...

ide_generic: please use "probe_mask=0x3f" module parameter for probing all legacy ISAH|

NTFS driver 2.1.30 [Flags: R-W MODULE].

NTFS volume version 3.1.

sscriptsslive-premount ... done.

FAT: utf8 is not a recommended I0 charset for FAT filesystems, filesystem will be cas|

aufs: module iz from the staging directory, the guality is unknown, you have been war|

aufs Z.1-standalone.tree-38-rchN-20110228

loop: module loaded

squashfs: version 4.0 (2009-01-31) Phillip Lougher

»scriptsslive-realprenount ... done.

"ssfilesystem.squashfs” via "sdeuvsloopd" .

sscriptsrs1ive-botton

done.
done.
preseed file ... done.

sscriptssinit-botton ... done.

INIT: version £.88 booting

zing makefile—

style concurrent boot in runlevel 3.

Once the image creation environment is booted up, a warning message displays asking whether you want
to continue. Note that if you create the recovery image, then any files copied in the /home/partimag
directory will be deleted. If you want to save the files in the USB partition image directory, you must
exit the recovery environment and copy the files to another disk. Press Y (case insensitive) to continue with

the |mage creation.
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4. The recovery environment starts to copy the entire hard drive to your USB drive. This may take several
minutes. Wait until the process is complete.

WARNING

Do NOT remove the USB drive from the computer during the data copy process.
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5. Choose whether to power down the computer (press 0), reboot (press 1), access the console terminal (to
access a console TTY, press 2), or re-initiate the entire procedure (press 3).

WARNING

Do NOT remove the USB drive from the computer until you have rebooted or powered down the system.

done!

or the file

6. Power down the system and remove the USB drive.

The recovery environment setup is complete and you have created an OS image in the USB
Folder\home\partimag\os_image folder. Label the USB drive and store it in a safe place.

CE IR « NEWVOLUME (D) » home » partimag » e

Organize v = Open Share with + Mew folder

-

by Mame Date modified Type Siz

[ Favorites
BE Desktop os_image 6/15/2014 58 PM  File folder
4 Downloads

‘| Recent Places

- Libraries

| Documents

m

@' Music
k=| Pictures

E Videos

M Computer
&, Local Disk (C3)
= NEW VOLUME (C
ttl-l Metwork
- 4 I 3

os_image Date modified: 6/15/2014 5:58 PM

File folder
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Moxa SynMap OID Table

This appendix provides information on the Moxa SynMap OID table.
The following topics are covered in this appendix:

0 Moxa SynMap OID Table
O HOST RESOURCE OID Table
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Moxa SynMap OID Table

The following table shows the full list of Moxa SynMap OIDs.

Item Name oID MAX-Access Description Support

productName 1.3.6.1.4.1.8691.17.1.1.1.0 | read-only Show the product name |

productDesc 1.3.6.1.4.1.8691.17.1.1.2.0 | read-only Show the product short
description

productVersion 1.3.6.1.4.1.8691.17.1.1.3.0 | read-only Show the product 4
version

productBuildDate 1.3.6.1.4.1.8691.17.1.1.4.0 | read-only Show the product’s last |
build date; the format is
YYMMDDHH

biosVersion 1.3.6.1.4.1.8691.17.1.4.1 read-only Show the BIOS version

biosSaveSetting 1.3.6.1.4.1.8691.17.1.4.2 read-write Write: 1 saves the bios
setting

Read: 0 means the
setting has been applied
biosSettingStatus 1.3.6.1.4.1.8691.17.1.4.3 read-only Show a comparison of
“bios CMOS setting” and
“bios new setting”

bootDeviceStatus 1.3.6.1.4.1.8691.17.1.4.4.1 |read-only Show the currently
active boot devices
firstBootDevice 1.3.6.1.4.1.8691.17.1.4.4.2 | read-write Read: Show the current

first boot device
Write: Set the boot

device
pwrOnAfterPwrFail |1.3.6.1.4.1.8691.17.1.4.8.1 | read-write Set the computer to
power on after a power
failure
pwrLanWakeUp 1.3.6.1.4.1.8691.17.1.4.8.3 | read-write Enable/Disable wake on
LAN functionality
tempSensorsIndex 1.3.6.1.4.1.8691.17.1. |read-only Reference index for each | v
5.1.1.1.1 observed device
tempSensorsDevice |1.3.6.1.4.1.8691.17.1.5.1.1. | read-only The name of the 4
1.2 temperature sensor
being read
tempSensorsValue |[1.3.6.1.4.1.8691.17.1.5.1.1.|read-only The temperature of this |V
1.3 sensor in mC
voltSensorsIndex 1.3.6.1.4.1.8691.17.1.5.1.2. | read-only Reference index for each | v
1.1 observed device
voltSensorsDevice 1.3.6.1.4.1.8691.17.1.5.1.2. | read-only The name of the device |V
1.2 we are reading.
voltSensorsValue 1.3.6.1.4.1.8691.17.1.5.1.2. | read-only The voltage in mV 4
1.3
ioDiNumber 1.3.6.1.4.1.8691.17.1.6.1.2. | read-only Number of digital input |V
1.0 pins in the current
system
diIndex 1.3.6.1.4.1.8691.17.1.6.1.2. | read-only Reference index of each |V
2.1.1 digital input pin
diPort 1.3.6.1.4.1.8691.17.1.6.1.2. | read-only Port number of the v
2.1.2 digital input pin
divValue 1.3.6.1.4.1.8691.17.1.6.1.2. | read-only Digital input status: 4
2.1.3 0 is low, 1 is high
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Item Name OoID MAX-Access Description Support
diTrapEnable 1.3.6.1.4.1.8691.17.1.6.1.1. | read-write Agent will send a trap
2.1.4 message when the
digital input pin status
has changed and this
object is enabled
ioDoNumber 1.3.6.1.4.1.8691.17.1.6.1.2. | read-only Number of digital output | v
3.0 pins in the current
system
doIndex 1.3.6.1.4.1.8691.17.1.6.1.1. | read-only Reference index of each |V
4.1.1 digital output pin
doPort 1.3.6.1.4.1.8691.17.1.6.1.2. | read-only Port number of the 4
4.1.2 digital output pin
doValue 1.3.6.1.4.1.8691.17.1.6.1.2. | read-write Digital output status: 4
4.1.3 0 is low, 1 is high
uartNumber 1.3.6.1.4.1.8691.17.1.6.3.1 |read-only Number of internal v
UARTSs in the current
system
uartIndex 1.3.6.1.4.1.8691.17.1.6.3.2. | read-only Reference index of each |V
1.1 UART port
uartType 1.3.6.1.4.1.8691.17.1.6.3.2. | read-write UART mode: 4
1.2 0 is RS232,
1 is RS485 2-wire,
2 is RS422,
3 is RS485 4-wire
usbNumber 1.3.6.1.4.1.8691.17.1.6.3.1. | read-only Number of ports,
0 regardless of their
current state, in the usb
general port table
usbDevicelndex 1.3.6.1.4.1.8691.17.1.6.4.1. | read-only The index is identical to
3.1.1 usbPortIndex for the
corresponding USB port
usbDeviceVendorID |1.3.6.1.4.1.8691.17.1.6.4.1. | read-only The USB device port
3.1.2 vendor HEX-formatted
string, as it is provided
to the USB host by the
USB device
usbDeviceProductID | 1.3.6.1.4.1.8691.17.1.6.4.1. | read-only The product ID
3.1.3 HEX-formatted string as
it is provided to the USB
host by the USB device
usbDeviceActiveClas|1.3.6.1.4.1.8691.17.1.6.4.1. | read-only Returns the USB Device
s 3.1.4 Class type of the active
configuration
usbPlugTrapEnable |1.3.6.1.4.1.8691.17.1.6.4.1. |read-write Agent will send a trap
4 message when a USB
device is inserted or
removed, and this object
is enabled
moxaSystemTrapIP |1.3.6.1.4.1.8691.17.1.9.1.0 |read-write Set Trap IP address 4
moxaSystemTrapCo | 1.3.6.1.4.1.8691.17.1.9.2.0 |read-write Trap community 4

mmunity
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HOST RESOURCE OID Table

The following table shows Host Resource OIDs.

Item Name oID MAX-Access Description Support
hrProcessorTable 1.3.6.1.2.1.25.3.3 read-only Show CPU usage 4
hrStorageTable 1.3.6.1.2.1.25.2.3 read-only Show disk and memory |

usage
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